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Notice
Every effort was made to ensure that the information in this book 
was complete and accurate at the time of printing.  However, 
information is subject to change.

Avaya Web Page
The world wide web home page for Avaya is:
http://www.avaya.com

Preventing Toll Fraud 
Toll Fraud is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not 
a corporate employee, agent, subcontractor, or working on your 
company’s behalf). Be aware that there is a risk of toll fraud asso-
ciated with your system and that, if toll fraud occurs, it can result 
in substantial additional charges for your telecommunications ser-
vices.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you 
need technical assistance or support, call the Technical Service 
Center’s Toll Fraud Intervention Hotline at 1.800.643.2353.

Providing Telecommunications Security
Telecommunications security of voice, data, and/or video commu-
nications is the prevention of any type of intrusion to, that is, 
either unauthorized or malicious access to or use of, your com-
pany’s telecommunications equipment by some party.

Your company’s “telecommunications equipment” includes both 
this Avaya product and any other voice/data/video equipment that 
could be accessed via this Avaya product (that is, “networked 
equipment”).

An “outside party” is anyone who is not a corporate employee, 
agent, subcontractor, or working on your company’s behalf. 
Whereas, a “malicious party” is Anyone, including someone who 
may be otherwise authorized, who accesses your telecommunica-
tions equipment with either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time-mul-
tiplexed and/or circuit-based) or asynchronous (character-, mes-
sage-, or packet-based) equipment or interfaces for reasons of:

• Utilization (of capabilities special to the accessed equip-
ment)

• Theft (such as, of intellectual property, financial assets, or 
toll-facility access)

• Eavesdropping (privacy invasions to humans)
• Mischief (troubling, but apparently innocuous, tampering)
• Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there may be a risk of unauthorized intrusions asso-
ciated with your system and/or its networked equipment. Also 
realize that, if such an intrusion should occur, it could result in a 
variety of losses to your company, including but not limited to, 
human/data privacy, intellectual property, material assets, finan-
cial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company’s Telecommunications 
Security
The final responsibility for securing both this system and its net-
worked equipment rests with you – an Avaya customer’s system 
administrator, your telecommunications peers, and your managers. 
Base the fulfillment of your responsibility on acquired knowledge 
and resources from a variety of sources including but not limited 
to:

• Installation documents
• System administration documents
• Security documents
• Hardware-/software-based security tools
• Shared information between you and your peers
• Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you 
and your peers should carefully program and configure your:

• Avaya provided telecommunications systems and their 
interfaces

• Avaya provided software applications, as well as their 
underlying hardware/software platforms and interfaces

• Any other equipment networked to your Avaya products

Trademarks
See the preface of this document.

Ordering Information
Call: Avaya Publications Center
Voice 1 800 457-1235   International Voice +1 207-866-6701
Fax    1 800 457-1764      International Fax +1 207-626-7269
Write: GlobalWare Solutions

200 Ward Hill Avenue
Haverhill, MA 01835  USA

 Attention: Avaya Account Management
Email: totalware@gwsmail.com
For additional documents, refer to the section in “About This 
Book” entitled “Related Resources.” 

Obtaining Products
To learn more about Avaya products and to order products, contact 
Avaya Direct, the direct-market organization of Avaya Business 
Communications Systems. Access their web site at 
www.avaya.com/direct or call 800-426-2455.

Comments
To comment on this document, return the comment card at the 
front of the document.
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This book explains how to install and configure Avaya 
MultiVantage™ Configuration Manager (Configuration Manager), 
how to test the installation, and how to troubleshoot it. 


������������

Installing and setting up Configuration Manager requires 
familiarity with network administration, knowledge of the Red Hat 
implementation of the Linux operating system, and proficiency 
with Linux administration. This knowledge is not taught in this 
book but is essential for a successful installation. 

For this reason, we highly recommend that workstation or 
network administrators take the primary role in installation.

�
��
���������
��

We wrote this book for workstation or network administrators.

	�
��
���
��������
����������

In this book, we use the following typographical conventions:

• We use bold type for emphasis and for any information that 
you should type; for example: save translation.

• We use Courier font for any information that the computer 
screen displays; for example: login.

• We use arrows to indicate options that you should select on 
cascading menus; for example: “Select File>Open” means 
choose the “Open” option from the “File” menu.



�������
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You may find the following additional resources helpful.

For help using Configuration Manager, look in the Configuration 
Manager online help. It explains how to perform basic administration 
tasks. To access the online help, start the Configuration Manager client 
and choose Help>Help Topics.

For help with complex administration tasks, see the Administrator’s Guide 
for Avaya MultiVantage™ Software, which explains system features and 
interactions in detail. You can access this document from the VisAbility 
home page.

��������������������
��

Let us know how this book measured up to your expectations. Your 
opinions are crucial to helping us meet your needs! You can send us 
your comments by mail, fax, or e-mail, as follows:

Mail: Avaya, Inc.
Configuration Manager Documentation Team
Room 1E-124
307 Middletown Lincroft Rd.
Lincroft, NJ 07738
USA

Fax: Configuration Manager Documentation Team
+ 1 732 817-2469

E-mail: document@avaya.com
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To view or download the latest version of this book, complete the 
following steps:

1.  Install your internet browser.

Most computers are sold with browsers already installed.

2.  Get access to the Internet.

If you do not already have access to the Internet, contact an 
Internet Service Provider (ISP) and set up an account.

3.  Set up your browser preferences.

Refer to the documentation that came with your browser.

4.  Install Adobe Acrobat Reader with Search, version 5.0 or later.

This is available on your CD-ROM or from: http://
www.adobe.com.

5.  Access http://www.avaya.com/support

6.  Click Product Documentation.

7.  Click System and Network Management.

8.  Under the heading “VisAbility Management Suite,” locate the 
heading, “Avaya MultiVantage™ Configuration Manager” and 
then click the link corresponding to the software release for 
which you want documentation.

9.  Locate the title of the book you want and then click it.

http://www.avaya.com/support


 �!����$�����&����	������������������
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To order paper copies of this book, call or write us and request the 
following publication:

Order: Document Number:555-233-137
Issue: Issue  3
Date: November 2002

Call: Avaya Publications Center
Voice: 1 800 457 1235
Fax: 1 800 457 1764

If you are calling from somewhere that cannot access US 1-
800 numbers, then call:
Voice: + 1 207 866 6701
Fax: + 1 207 626 7269

Write: Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835
USA
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Avaya provides our customers with a variety of planning, 
consulting, and technical services. The sections below briefly 
describe the resources and services that are available.

Client executives are your primary contact to obtain information 
and explore options to meet your specific business needs. 

"����
)� ����!���������
���������


If you are located within the United States and you want help 
installing or setting up Avaya MultiVantage™ Configuration 
Manager (Configuration Manager), call your Avaya representative.

If you are located outside the United States, call your Avaya 
representative or distributor. Call at least 4 weeks before the date 
on which you want to install Configuration Manager. 

���*������
���)*��
��	�
�����
)�#���	%

ATAC works with client teams to develop detailed solutions for 
connectivity to MultiVantage™ solutions. The ATAC also designs 
network configurations to support Configuration Manager.

���*����+����(��!�����+���+�
�����
�
,��������#�(�,%

For this product, RNIS offers customers the following services:

• Verify platform readiness

• Remotely install Configuration Manager

• Configure the network management server for each voice 
system to be managed by Configuration Manager

• Verify customer acceptance



����*������
�����,�������$�)�
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The TSO provides support for Configuration Manager to client 
teams, field technicians, and customers. The TSO will bill 
customers for support on a time and materials basis if the following 
conditions exist:

• Customers do not have a current maintenance agreement

• Customers do not procure and install the required systems 
and software as defined in the VisAbility Management Suite 
Services Support Plan

• Customers request support that is outside the purchase 
agreement

The TSO does not support hardware or software that customers 
purchase from third-party vendors.

���*��(��!����&�
�)�+�
��,���!����,*���+�
,�������"�����#(&,,,%

The Network Management Software Systems Support (NMSSS) 
group in Tampa Bay answers customer calls about applications in 
the VisAbility Management Suite. NMSSS will either answer your 
questions directly or connect you with an associate who can 
answer questions about your application.

���*��	�
������
���+����


You may find the following contact information helpful at various 
times during the process of installing and setting up this product 
This information was accurate at the time this book went to press. 
We update this information with each new release of 
Configuration Manager.



Avaya MultiVantage™ Configuration Manager Installation and Configuration 11

�����������
��(������

Customers can access only the resources in Table 1 (not Table 2). To view 
Avaya web sites, Avaya recommends that you use Internet Explorer. 

Table 1.  Customer-Accessible Resources

Resource Contact Information

Avaya Support Centre http://support.avaya.com/

Network Management 
Software Systems 
Support group

1-800-237-0016.

Avaya Technical Services 
Organization (TSO)

For calls about Avaya Site Administration: 1-
800-242-2121 extension 15312.

Remote Network 
Implementation Services 
(RNIS)

http://www1.avaya.com/enterprise/who/
docs/implementationservices/
fullprodinfo.html

Toll Fraud Intervention 1-800-643-2353 prompt 1.

Table 2.  Avaya Internal Resources

Resource Contact Information

Avaya Enterprise 
Management Support

http://aem-support.dr.avaya.com/

Avaya Technology and 
Consulting Team (ATAC)

Phone: 1-888-297-4700

Main site (requires a password): 

http://forum.avaya.com

Remote Network 
Implementation Services 
(RNIS)

http://associate2.avaya.com/sales_market/
products/data-implementation-services/

VisAbility Management 
Services Support Plan

http://associate2.avaya.com/solution/
support_plans/#Enterprise

VMS002 Form http://associate2.avaya.com/sales_market/
products/data-implementation-services/ 

Then click “Avaya VisAbility™ Management 
Suite Configuration Request Form #2.”

http://support.avaya.com/
http://aem-support.dr.avaya.com/
http://sdsc.avaya.com
http://associate2.avaya.com/sales_market/products/data-implementation-services/


������.
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The table below lists contact information for third-party vendors.

,*���+�,������*�(������

Customers are solely responsible for the security of their system, 
network, and access to hardware and software. The sections below 
define the precautions that all customers should take to maintain 
the security of their systems.

(��!����,������*

Configuration Manager uses the standard security features on the 
Red Hat Linux. 

Avaya strongly recommends that customers use passwords to 
prohibit access to their systems and to routinely change those 
passwords to maintain security.

Customers should always change passwords immediately 
after external vendors have completed installation, 
maintenance, troubleshooting, or other tasks on their 
system.

Table 3.  Vendor web sites

Vendor Web Sites

Microsoft Main site: http://www.microsoft.com

Red Hat Linux Main site: http://www.redhat.com

! SECURITY ALERT:

http://www.microsoft.com
http://www.redhat.com
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Although Configuration Manager is generally not at risk for toll fraud, 
customers are solely responsible for the security of their entire 
telecommunications system. 

Toll Fraud is the unauthorized use of a company’s telecommunications 
system by unauthorized parties. Unauthorized parties are persons other 
than the company’s employees, agents, subcontractors, or persons 
working on behalf of the company. Toll fraud can result in substantial 
additional charges for the company’s telecommunications services.

The company’s system manager is responsible for the security of the 
company’s system, which includes programming and configuring the 
equipment to prevent unauthorized use.

���*��
0������+��

Avaya does not warrant that this product is immune from or will prevent 
unauthorized use of common-carrier telecommunications services or 
facilities accessed through or connected to it. Avaya will not be 
responsible for any charges that result from such unauthorized use.

�����/�����
�
�����
���


If customers suspect that they are a victims of toll fraud and need 
technical assistance, they should refer to the phone number listed for 
"Toll Fraud Intervention" on page 11.
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Avaya MultiVantage™ Configuration Manager (Configuration 
Manager) is a client-server based MultiVantage software 
administration application that offers these powerful features:

• enables multiple administrators to administer the same (or 
separate) MultiVantage solutions at the same time, 
remotely;

• offers graphical station and system administration screens;

• offers easy-to-use wizards for basic administration tasks;

• lets you cut through (using terminal emulation) to 
administer other telephony devices.

�
���������
�	��������

1.  Prepare the Configuration Manager server.

a.  Purchase computers (if necessary) that meet the 
hardware and software requirements on page 16.

b.  Install computers (if necessary).

c.  Ensure TCP/IP connectivity between the Configuration 
Manager server, Configuration Manager client, and 
MultiVantage solutions. Troubleshoot problems with the 
LAN/WAN administrator.

2.  Prepare MultiVantage solutions. (page 17)

3.  Install Configuration Manager. (page 19)

4.  Set up Configuration Manager. (page 29)

5.  Test the Installation.

Test that a Configuration Manager client can connect to 
each voice system. Test that clients can (or cannot) access 
the parts of Configuration Manager that you specified when 
setting user permissions.

6.  Troubleshoot, if appropriate.
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Avaya MultiVantage™ Configuration Manager (Configuration 
Manager) client workstations should meet the following 
requirements: 

Parameter Requirement

Operating 
system

Windows NT 4.0, 98, XP, or 2000.

Other 
software

Netscape 6.2 (provided), or
Internet Explorer 5.5 and
Java Runtime Environment 1.3.1_02 (provided)

Processor PII-600 MHz

RAM 256 MB

Available 
Disk Space

Minimum: 100 MB on the drive that contains the 
Windows System folder (normally but not always 
the C: drive)

Maximum: Up to 1GB (if this computer is running 
all client applications in the suite)

CD-ROM Optional

Network 
Connectivity

TCP/IP

IP Addresses Static or dynamic (DNS preferred)

Display SVGA



�,�������������+�
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Any server that you use to run Configuration Manager server 
software must meet the following requirements:

���� �������++�
�����
�

For Configuration Manager to work, when Red Hat is installed and 
set up on the Configuration Manager server, specific options Red 
Hat must be enabled. 

Instructions for setting up Red Hat are available in the Avaya 
VisAbility Management Suite Implementation Guidelines, which is 
available from your client executive. The instructions are also 
available in the Configuring Red Hat Linux document, which is 
available under the “VisAbility” heading of the System and 
Network Management area of the Support Centre web site. (see 
"How to Get This Book (and Others) on the Web" on page 7).

Parameter Recommended

Operating 
system

Linux 7.3

Processor 1.3 GHz Pentium 3 or Pentium 4

RAM 1 GB

Available 
Disk Space

40 GB

CD-ROM Required for installation

Network 
Connectivity

10/100 network card

Modem 56K required for remote support
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Before you can use Avaya MultiVantage™ Configuration Manager 
(Configuration Manager), you must complete the following 
activities for each MultiVantage solution that you want to access 
using Configuration Manager:

• Connect MultiVantage solutions to the network

• Create a login for Configuration Manager on each 
MultiVantage Solution.

	�

����
)����������������
��!���

To function properly, Configuration Manager must be connected to 
your MultiVantage solutions via a TCP/IP connection. New Avaya 
voice systems have TCP/IP connectivity built-in, whereas legacy 
voice systems require the use of a C-LAN circuit pack. Figure 1 
illustrates a TCP/IP connection from the Configuration Manager 
server to a legacy Avaya voice system via a C-LAN circuit pack. 



�	�����
)���&����4�
��)������!������)�
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Figure 1.  Connecting via C-LAN circuit pack

	�����
)���&����4�
��)������!������)�


On each MultiVantage Solution that you want to administer using 
Configuration Manager, you must create a unique login and enable 
it with super-user privileges. For instructions, see the Avaya 
MultiVantage™ Systems Little Instruction Book for Basic Administration. 
A copy is available on the VisAbility home page and on the 
VisAbility software installation CDs.

cydrdta LJK 103100

MultiVantage Solution

C-LAN

259A 
adapter

RJ-45 RJ-45

LAN

Config. Mgr. server

Category 5
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Before you install Avaya MultiVantage™ Configuration Manager 
(Configuration Manager), be sure that the computers you plan to 
install it on meet the requirements listed in "System 
Requirements" on page 15.

Configuration Manager requires a functioning LAN to operate. The 
instructions in this section assume that your LAN is fully 
operational and that all Configuration Manager computers can 
ping each other. 

To install Configuration Manager server software, you must have a 
root login on the Red Hat Linux server. To install the Configuration 
Manager client shortcut, you must have Windows Administrator 
privileges. 

"���
)����*������������	�
��)������
�&�
�)��

If your company has a support agreement with Avaya, then you 
need to install a modem on the Linux server. This enables Avaya 
service personnel to remotely troubleshoot and correct problems. If 
you ever need an Avaya service representative to perform remote 
troubleshooting or maintenance, make sure that you have the 
modem phone number on hand.
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To install Configuration Manager server software, you must have a 
root login on the Red Hat Linux server. Then, complete the 
following steps:

1.  Insert the "Avaya VisAbility Management Suite: Linux 
Server Installation" CD into the CD-ROM drive.

The CD browser window appears automatically. 

2.  Open terminal emulation by clicking the terminal emulation 
icon in the Red Hat toolbar.

3.  In the terminal emulation window, type cd /mnt/cdrom 
and press Enter.

4.  Type ./vms_setup.bin and press Enter.

Red Hat displays the installation wizard.

5.  At the Welcome page, click Next.

6.  If you see a message that rpmspec has not already been 
installed, click “Yes, launch the install routine for rpmspec 
for me” and click Next.

7.  If you see a message box that gives you the option to select 
All or Custom, choose whether to install all products (All) 
or just a subset (Custom).

If you choose “All”, go to Step 9.

If you choose “Custom,” go to Step 8.

8.  In the product installation screen, ensure that MultiVantage 
Configuration Manager is selected and click Next.

Darkly shaded or depressed buttons are selected. Raised 
buttons are NOT selected. 

9.  Review the summary page, and do one of the following:

— If the information is accurate, click Next.

— If the information is inaccurate, click Back to correct the 
error.

10.  Read the Sun license agreement, click Accept if you accept 
it, and click Next.
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11.  Read the Apache license agreement, click Accept if you accept 
it, and click Next.

12.  Read the Configuration Manager license agreement, click 
Accept if you accept it, and click Next.

The installation wizard displays the message, “Installing System 
Management Linux Server. Please wait.” Subsequently, the 
installer displays the message, “Creating uninstaller.” Finally, it 
displays the message, “The InstallShield Wizard has successfully 
installed System Management Linux Server. Click Finish to exit 
the wizard.”

13.  Click Finish.

The wizard closes.

14.  In the terminal emulation window, type reboot and press 
Enter.

This ensures that the Tomcat web server shuts down and restarts 
properly. Wait while the system reboots. After the system has 
rebooted, it displays the Red Hat login dialog box.

�
������
)�	�
��)������
�&�
�)���	���
��
,���!���

To install Configuration Manager clients, you must use a Windows login 
that has Administrator privileges. Save yourself time by ensuring that 
you have adequate hard disk space to install this product (see page 15). 
Then, complete the following sections.
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1.  Shut down all applications running on the PC.

2.  Insert the CD, "Avaya VisAbility Management Suite: Windows 
Client Installation" into the CD-ROM drive.

Wait a moment for the CD browser window to appear 
automatically. 

3.  Click Install Network Management Client Products.

The installation program prepares the installation wizard and 
displays the Welcome page.
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4.  At the Welcome page, click Next.

The installation program displays a list of the applications 
and shortcuts that you can install. By default, the option for 
Required Components is checked. 

5.  Select Shortcut for MultiVantage Configuration 
Manager, along with any other programs or shortcuts you 
want to install.

When you select the shortcut for Configuration Manager, 
the installation program automatically also selects the 
option for Avaya Site Administration because Avaya Site 
Administration must be installed with Configuration 
Manager to enable cut-thru access to voice systems.

6.  Verify that you have enough available hard disk space on 
your PC to install the shortcut(s).

a.  If you don’t, click Cancel to exit the installation 
program. 

Restart the installation at Step 1 when you have made 
adequate hard disk space available.

b.  If you do, click Next.

The installation program displays the summary page.

7.  Check the summary page and do one of the following:

a.  If it contains errors, click Back to correct the errors. 

b.  If it is accurate, click Finish.

A note advises you that if an installation wizard asks you 
if you want to reboot, you should NOT reboot until the 
final installation wizard (in your situation) has run. 
Click OK.

Depending on which options you selected in Step 5, the 
master installation wizard launches one or more of the 
following installation wizards, in the following order:

—Netscape installation wizard

—Java Runtime Environment (only if you select a 
shortcut, Directory Enabled Management, or VAL 
Manager)

—Required components installation wizard

—Avaya Site Administration installation wizard
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—Avaya Terminal Emulation installation wizard

—VAL Manager installation wizard

—VoIP Monitor installation wizard

—System Management Client Shortcuts installation wizard.

—Adobe installation wizard

This book explains only the screens that appear if you select 
the Configuration Manager shortcut option. If you select 
additional options, you may see other screens in between the 
ones described below.
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First, The Java Runtime Environment installation wizard runs.

1.  Read the terms and conditions of the Sun license agreement, and 
do one of the following:

a.  If you agree to the terms and conditions, click Yes.

The installation wizard displays any Release Notes.

b.  If you do not agree to the terms and conditions, click Cancel.

This will terminate the installation wizard for this application. 
The installation program will display the wizard for the next 
application that you selected (if any) in Step 5 on page 22. In 
that event, refer to the installation documentation for 
that application and skip the rest of this procedure.

2.  Specify the location where you want to install the JRE and click 
Next.

To change the location, click Browse and navigate to where you 
want to install the JRE.

3.  Specify the browser(s) that you want this JRE plug-in to work 
with and click Next.

The installation wizard copies the necessary files to your 
computer, then displays a message and exits when the installation 
is complete.

Then, the Required Components installation wizard runs.
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When you install the Required Components, the installation 
program is setting up the necessary files so that you can launch 
VisAbility Management Suite applications from the VisAbility 
home page.

1.  At the Welcome screen, click Next.

2.  Specify the location where you want to install the Required 
Components and click Next.

To change the location, click Browse and navigate to where 
you want to install the Required Components.

3.  Enter the computer name or fully-qualified domain name 
(FQDN) of the VisAbility Network Management Server.

The VisAbility Network Management Server is either a 
Windows server or a Linux server. It is the location where 
this client PC will look for the VisAbility home page. If you 
have installed (or plan to install) both the Windows server 
and the Linux server, enter the Windows server information 
here. If you have installed (or plan to install) only the Linux 
server, then enter the Linux server information here.

You can type the computer name or the FQDN. The FQDN is 
the host name followed by the IP domain name. For 
example: dnapc1.department.company.com. 

4.  Check the summary page and do one of the following:

a.  If it contains errors, click Back to correct the errors. 

b.  If it is accurate, click Next.

The installation wizard displays a message that the 
installation of Required Components is complete.

5.  Click Finish.

The Avaya Site Administration installation wizard runs. 



Avaya MultiVantage™ Configuration Manager Installation and Configuration 25

�
������
)�	�
��)������
�&�
�)��

�
������
)����*��,������+�
��������


1.  At the Welcome screen, click Next.

The installation wizard checks to see if you have earlier versions 
of Avaya Site Administration already installed on this computer. If 
you do, it will indicate this, and it will ask if you want the wizard 
to remove the old version, or if you want to remove it yourself.

2.  When you see the above message, do one of the following:

a.  To preserve your Avaya Site Administration settings, click Yes.

We recommend this option.

b.  To uninstall the old version yourself, click No. 

This will terminate the installation wizard for this application. 
The master installation program will display the next 
installation wizard (if any) corresponding to the selections you 
chose in Step 5 on page 22.

After you finish any other installation wizards, and after you 
remove Avaya Site Administration yourself, you must restart 
the master installation wizard (Step 2 on page 21) to install 
Configuration Manager.

If the installation wizard does not detect a copy of Avaya Site 
Administration on this computer, then it displays the appropriate 
license agreements.

3.  If applicable, read the terms and conditions of the Avaya Site 
Administration license agreement, and do one of the following:

a.  If you agree to the terms and conditions, click Yes.

The installation wizard displays any Release Notes.

b.  If you do not agree to the terms and conditions, click Cancel.

This will terminate the installation wizard for this application. 
The installation program will display the wizard for the next 
application that you selected (if any) in Step 5 on page 22. In 
that event, refer to the installation documentation for 
that application and skip the rest of this procedure.

4.  Read the Release Notes and click Next.

If this is the first time Avaya Site Administration has been 
installed on this computer, then the installation wizard displays 
the Destination page.
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5.  If applicable, verify that the pathname displayed in the 
“Destination Folder” field is where you want to install 
Avaya Site Administration

a.  If it is, click Next.

b.  If it isn’t, click Browse, specify to the location where 
you want to install, and click Next.

The installation wizard displays the summary page.

6.  Check the summary page and do one of the following:

a.  If it contains errors, click Back to correct the errors. 

b.  If it is accurate, click Finish.

7.  Indicate whether or not you want a shortcut for Avaya Site 
Administration installed on your desktop and click Next.

The installation wizard displays a message indicating that 
the Avaya Site Administration installation is complete. 
Then, the master installation program launches the 
installation wizard for Avaya VisAbility Management Suite 
Client Shortcuts.
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1.  At the Welcome screen, click Next.

2.  Enter the computer name or FQDN of the Configuration 
Manager server computer and click Next.

You recorded this information when you installed the 
Configuration Manager server software on Linux. The 
installation wizard then displays a summary page.

3.  Check the summary page and do one of the following:

a.  If it contains errors, click Back to correct the errors. 

b.  If it is accurate, click Finish.
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After the final wizard runs, a message appears indicating that the 
installation is complete and that you can now reboot your computer if 
any of the installation wizards indicated that this was necessary. To finish 
the installation, complete the following steps:

1.  On the CD Browser screen, click Exit.

2.  Remove the CD from the CD-ROM drive.

3.  Reboot (if appropriate).

Repeat this process, starting at "Starting the Installation" on page 21, on 
all other Windows computers that you want to serve as Configuration 
Manager clients.
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This section explains how to remove Configuration Manager. This 
procedure contains only the basic steps. For more information on 
the Linux package uninstall, refer to the Linux system 
documentation.

! CAUTION: To preserve current data, back up data to a file or archive 
device. 


�������� Only root users should remove Configuration Manager. The 
remove script prompts you to back up the database to a file or an 
archive device. 

1.  Close all windows and applications. 

2.  Log off the network server.

3.  Optional. If you are backing up the database before you 
remove Configuration Manager, connect the archive device.

4.  At the login prompt, type ���� and press ENTER.

5.  At the password prompt, type the root password and press 
ENTER

6.  Open a terminal window

7.  Type ��8����8�����8���*�8�
�
����� and press ENTER.

Doing so sets up the Configuration Manager environment.

8.  Type 9 8�
�
�������9��
 and press ENTER.

The installation wizard appears followed by the Welcome 
screen.

9.  Select the application to be removed

10.  Click NEXT and follow the wizard prompts.
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To set up Avaya MultiVantage™ Configuration Manager 
(Configuration Manager), you will complete the following basic 
activities, which are described in more detail in this chapter:

1.  Start Configuration Manager. (page 29)

2.  Set up the Configuration Manager server. (page 30)

3.  Add voice systems and or messaging systems. (page 30)

4.  Change the administrative password. (page 33)

5.  Add users and specify permissions. (page 33)

6.  Start the queue. (page 34)

7.  Initialize voice systems. (page 35)
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1.  Go to an Configuration Manager client PC and choose 

Start>Programs>Avaya>MultiVantage Configuration 
Manager.

The above step assumes that you installed Configuration 
Manager in the default location. If you installed it 
elsewhere, navigate to that location to start Configuration 
Manager.

2.  At the Login dialog box, enter your Login ID, your password, 
and click Login.

The first time you start Configuration Manager, enter the 
administrative Login ID admin and the password 
admin123. 
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The first time you log into Configuration Manager, it will 
automatically display the Configuration Manager Server 
configuration wizard. To set up the Configuration Manager server, 
complete the following steps:

1.  At the Welcome page, click Next.

2.  Enter the name for this server that you want to appear in 
Configuration Manager screens.

3.  (Optional) Complete any other fields on this screen.

4.  Click Next.

5.  Enter the IP Address of the Configuration Manager server.

(Optional) You can click the Ping buttons next to any of 
these addresses to check connectivity to those servers. After 
clicking Ping, click OK to close the response window.

6.  (Optional) Enter the Gateway IP addresses.

7.  (Optional) Specify the number of minutes after which 
inactive Configuration Manager users should automatically 
be disconnected from the server.

8.  Click Next.

Configuration Manager displays the Summary page.

9.  If the information presented is accurate, click Finish.

If it is not accurate, click Back to correct the error. If you 
click Finish, then Configuration Manager displays the Voice 
System Table, which you will use to add voice systems, as 
explained in the next section.
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1.  With the Voice System table displayed, click Add Device. 

Configuration Manager displays the Welcome page of the 
Add Device Configuration wizard.

2.  At the Welcome page, click Next. 

Configuration Manager displays the Company Information 
page and fills in some of the fields using information that 
you entered when you configured Configuration Manager 
server.

3.  (Optional) Enter any supplemental company information.
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4.  Click Next.

5.  Complete the fields as follows and click Next. 

Field Name Description

Device Name Enter the name of the voice system that you 
want to appear in Configuration Manager 
screens. What you enter here does not affect the 
voice system.

IP Address Enter the IP address associated with the voice 
system.

Port Number Enter the voice system administration IP port 
number that Configuration Manager should use 
to communicate with this voice system.

Cut-Through Port 
Number

Enter the IP port number that Configuration 
Manager should use when attempting to “cut 
through” to a MultiVantage solution using 
terminal emulation.

Group/Region 
Assignment

If your company uses any type of regional code 
or designation, enter it here. 

Voice System Type Enter the type of voice system this is (for 
example, DEFINITY R).

Version Enter the release number of the MultiVantage 
software that is running on this voice system.

Administrative 
Login

Enter the login ID that Configuration Manager 
should use to access this system.

Password Enter the password associated with this login 
ID. This is not applicable if you selected ASG.

ASG Key Enter the ASG Key associated with this login ID. 
This is not applicable if you are not using ASG.

Function Location 
Number

If your company uses any type of location code, 
enter it here. 

Site Phone 
Number

Enter the phone number of a person who is 
physically proximate to this voice system.
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6.  (Optional) Specify information about any messaging systems 
that you want Configuration Manager to be able to access, 
and click Next.

7.  Verify the information that you entered.

If it is accurate, click Finish. If it is not, click Back to fix the 
error. If you click Finish, Configuration Manager displays 
the message, “Congratulations!”

8.  Click OK.

Configuration Manager displays the Voice Systems table 
again.

9.  To exit the table, click Cancel.

The first time you click Cancel, the Configuration Manager 
client closes. Restart the client. Subsequently, when you 
click Cancel on this screen, it simply clears the right side of 
the screen.

Field Name Description

Messaging System 
Name

Enter the name of the messaging system that 
you want to appear in Configuration Manager 
screens. What you enter here does not affect the 
messaging system.

IP Address Enter the IP address associated with this 
messaging system.

Port Number Enter the messaging system administration IP 
port number that Configuration Manager 
should use to communicate with this messaging 
system. 

Login Name Enter the login ID that Configuration Manager 
should use to access this system.

Password Enter the password associated with this login ID

System Password This is a second password that exists on 
some messaging systems. If you messaging 
system has a system password, enter it 
here.
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So that anyone reading this manual cannot log in to your copy of 
Configuration Manager as an administrator, it is highly advisable to 
change the administrative password very shortly after logging into 
Configuration Manager for the first time. 

To change the administrative password, complete the following steps:

1.  With the MCM Manager tab displayed, click User 
Configuration.

Configuration Manager displays the Configuration Manager User 
table.

2.  Highlight the row associated with the Login ID admin and click 
Update User.

Configuration Manager displays the Update User dialog box.

3.  Click Change next to the Password label.

Configuration Manager displays the Change Password dialog box.

4.  Enter the new password twice and click Change.

Remember to note the new password and save it in a secure 
location.
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To add users, complete the following steps:

1.  From the MCM Manager tab, click MCM User Configuration.

2.  With the Configuration Manager Users tab on top, click Add 
User.

3.  Complete the Add User screen.

4.  Click Add.

5.  Click the Users on Switches tab.

6.  Click Add User.
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7.  Complete the fields on this page as follows, and click Add. 

a.  Select the user’s ID from the drop-down list.

b.  Enter and re-enter the password associated with that ID.

c.  Enter the user’s name, company name, title, and phone 
number (the required fields).

d.  From the list on the right, select the voice system(s) that 
you want this user to be able to access using 
Configuration Manager.

Shift-Click to select multiple contiguous voice systems. 

e.  Place a check mark in each check box corresponding to 
the access permissions you want this user to have on the 
voice system(s) that you selected in the previous step.

f.  (Optional) Complete the non-required fields.

8.  Repeat this process. for each user you want to add.
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You must start the queue running before you can use 
Configuration Manager to access or make changes to that voice 
system. To start the queue, complete the following steps:

1.  From the main screen, click the MCM Manager tab, if it is 
not already displayed.

2.  Click System Resources.

3.  Click Start Queue.

4.  Click OK.
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You must initialize each voice system that you want to use with 
Configuration Manager, before you use Configuration Manager to access 
or make changes to that system. To initialize a voice system in 
Configuration Manager, complete the following steps:

1.  From the main screen, click the MCM Manager tab, if it is not 
already displayed.

2.  Click System Resources.

3.  Click Initialize System.

4.  Click OK.
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A

ATAC
See “Avaya Technology and Consulting (ATAC)” on page 9.

M

MultiVantage software
The call processing software that runs on MultiVantage solutions. Formerly known as DEFINITY software.

MultiVantage solution
Any of the products that run MultiVantage software. Formerly known as DEFINITY system, DEFINITY ECS, 
switch, PBX, or voice system.

N

Network Management Server
This is the Windows box that you can install Windows-based VisAbility Management applications on.

Network Management System
A system that lets you monitor the health and status of devices on your data network. For example, 
HP OpenView.

R

RNIS
See “Avaya Remote Network Implementation Services (RNIS)” on page 9.

S

System Management Server
This is the Linux box that you install Configuration Manager on.

T

TSO
See “Avaya Technical Service Organization (TSO)” on page 10.
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